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 Introduction 

This Release and Upgrade Guide is designed to help you through the payroll upgrade for the 
2008-09 year end into the new 2009-10 tax year. It contains all the background information 
about the legislative and other changes introduced by the government and HMRC, and the 
changes to the software. The guide provides step-by-step points for planning and implementing 
the upgrade, and includes useful sources of further information. Make sure you follow the 
upgrade instructions carefully. 

When to Carry Out the Software Upgrade 
The software can be installed in any pay period before the end of the 2008-09 tax year. 
However, it must be installed before processing the 2008-09 year end. This will ensure that the 
software is in place ready for running year end procedures, submitting the year end returns to 
HMRC, and then to start processing in the 2009-10 tax year.  

You should aim to carry out the upgrade after the full payroll cycle in the pay period.  

Installation and Upgrade Instructions 
Software installation and upgrade instructions for Capital Gold Payroll and Online Filing 
Manager are included in each product’s Installation Guides. You must refer to those documents 
when installing the products.  

Adobe Reader (9.00) 
Adobe Reader (9.00) is included on the Capital Gold Payroll CD, so if this version or later is not 
installed on the computer, you can run the setup program provided to install a copy. Instructions 
on the use of Adobe Reader are provided with the Reader itself. 

Feedback 
Pegasus is interested to hear your views on the documents we provide. To give your feedback, 
send an email to feedback@pegasus.co.uk. Please type “Capital Gold Payroll Upgrade Guide” 
in the subject box. 

Please note that product support is not offered through the above email address. 

mailto:feedback@pegasus.co.uk�
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 Quick Overview of Legislative and Other Changes 

This section provides a high-level overview of the legislative changes to be introduced from 6 
April 2009. If you would like to know more in-depth information about these legislative changes 
after reading this section, further details are included in the next section of this guide. 

Full details of legislative changes are available in the official publications from HMRC/NICO and 
from your tax office.  

The legislative changes for the 2008-09 year end and 2009-10 tax year affect the submission of 
online year end returns to HMRC, the submission of online and printed in-year returns to 
HMRC; and the calculation of National Insurance Contributions, Statutory Adoption Pay, and 
Statutory Paternity Pay for adoption.  

Legislation and other requirements 
The legislative changes and changes introduced by HMRC that affect Pegasus products from 6 
April 2009 are the following:  

• State second pension (S2P) benefits are currently accrued based on the level of an 
employee’s earnings between the National Insurance lower earnings limit (LEL) and the 
upper earnings limit (UEL). From 6 April 2009, under the pension reform provisions of the 
2007 Pensions Act, which includes reforms to the state pension system, the S2P is being 
restructured to become a flat-rate state pension by around the year 2030. The Pensions 
Act introduces a new threshold for National Insurance calculations - the ‘Upper Accrual 
Point’ - to use instead of the UEL for accruing S2P entitlement and calculations of 
contracted-out rebate contributions.  

• The P45 form has been amended and a new plain-paper form has been introduced for 
employers that submit P45s online. All employers with 50 or more employees must 
submit P45 Part 1, P45 Part 3, and P46 in-year forms to HMRC online. Paper returns will 
not be accepted by HMRC from these employers. 

• New P46 forms have been introduced:  form P46 (Pen) for pension providers and 
employers who pay pensions and annuities (this replaces the form P160); and form P46 
(Expat) for employees who work for a overseas employer and are seconded to work in 
the United Kingdom. 

• Software products that submit in-year returns online must be able to receive digital 
receipts from HMRC. Digital receipts, also called the HMRCMark, are electronic 
responses that are sent by HMRC after online returns have been submitted. 

• Minor changes to the XML content of in-year online returns, and tightened-up validations. 
• Minor changes to the XML content of online Employer Annual Returns, and tightened-up 

validations. 
• HMRC has discontinued the use of the SSP1 (L) form. The form was previously used to 

link employee’s periods of sickness when they were employed by different employers. 

HMRC Payroll Standard and the Pensioner Payroll Standard 
From 6 April 2009, HMRC has made the following requirements mandatory for the Payroll 
Standard and Pensioner Payroll Standard:  

• To comply with the HMRC Payroll Standard, software products must be able to calculate 
Statutory Adoption Pay (SAP) and Statutory Paternity Pay for adoption (SPP - Adopt).  

Note: Statutory Maternity Pay (SMP) and Statutory Paternity Pay for New Births (SPP - 
Birth) are existing mandatory elements of the HMRC Payroll Standard. 

• To comply with the HMRC Pensioner Payroll Standard, software products must be able 
to submit the P46 (Pen) form (currently called PENNOT) online.  
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 More Detail of the Legislative and Other Changes 

Upper Accrual Point NIC threshold 
The Upper Accrual Point (UAP) is a new National Insurance threshold or level that is positioned 
between the current Earnings Threshold and the Upper Earnings Limit threshold. From 6 April 
2009, this new threshold is used to calculate National Insurance contributions (NICs) along with 
the existing thresholds. The calculation of Contracted Out Money Purchase (COMP) payments 
for employees who are members of a COMP pension scheme is also affected. 

The following table shows the thresholds that are used for National Insurance calculations in the 
2008-09 Tax year and those for the 2009-10 Tax year: 

  Applicable in tax year 

NIC Threshold Description 2008-09 2009-10 

Upper Earnings Level 
(UEL) 

When earnings exceed this level 
employees pay NICs at a rate of 
1% 

  

Upper Accrual Point 
(UAP) 

When earnings exceed this level 
NICs are payable using NI rates 
for earnings up to the UEL.  

  

Earnings Threshold 
(ET) 

When earnings exceed this level 
NICs are payable by both 
employees and employers.  

  

Lower Earnings Level 
(LEL) 

If earnings reach or exceed this 
level but do not exceed the ET, 
NICs are not payable but the 
employee still qualifies for state 
benefits. 

  

NIC Bandwidths 

National Insurance contributions are calculated and displayed according to these bandwidths: 
 2008-09 tax year 2009-10 tax year 

1d None Earnings above the UAP up to and 
including the UEL 

1c Earnings above the ET up to and 
including the UEL 

Earnings above the ET up to and 
including the UAP 

1b Earnings above the LEL up to and 
including the ET 

Earnings above the LEL up to and 
including the ET 

1a Earnings at the LEL  Earnings at the LEL  

This has the effect of splitting the old ‘Earnings between the ET and the UEL’ bandwidth into 
two new bandwidths:  

• Earnings between the ET and the UAP  
• Earnings between the UAP and the UEL.  

The calculation and reporting of NIC figures now involves additional steps for these new 
bandwidths. 

Note: The Earnings up to the LEL and Earnings between the LEL and ET bandwidths are 
not affected by the introduction of the Upper Accrual Point threshold. 
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NI Bandwidths, and Employee and Employer NI Rates 
These are the NI bandwidths and employee and employer rates for the 2009-10 tax year. 
Please note the following:  
• There are no rate changes for NI codes A, B, C, J, and X.   
• For NI codes D, E, L (COSR schemes), and NI codes F, G, S (COMP schemes):  

• The reduced contracted-out rate calculation is based on earnings from LEL up to 
the UAP.   

• The percentage calculations for earnings from the UAP to the UEL are at the non 
contracted-out rate.   

• All earnings above the UEL are calculated at 1% for employee contributions and 12.8% for 
employer contributions. 

NI Bandwidths 
 LEL ET UAP UEL 

Weekly 95.00 110.00 770.00 844.00 

Twice Weekly 190.00 220.00 1540.00 1688.00 

Four Weekly 380.00 440.00 3080.00 3375.00 

Monthly 412.00 476.00 3337.00 3656.00 

Yearly 4940.00 5715.00 40040.00 43875.00 
Employee Rates 

 A B C D E F G J L S 

Above UEL 1% 1% 0% 1% 1% 1% 1% 1% 1% 1% 

UAP - UEL 11% 4.85% 0% 11% 4.85% 11% 4.85% 1% 1% 1% 

ET - UAP 11% 4.85% 0% 9.4% 4.85% 9.4% 4.85% 1% 1% 1% 

LEL - ET 0% 0% 0% 1.6% 0% 1.6% 0% 0% 1.6% 1.6% 

Employer Rates 

 A B C D E F G J L S 

Above UEL 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 

UAP - UEL 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 12.8% 

ET - UAP 12.8% 12.8% 12.8% 9.1% 9.1% 11.4% 11.4% 12.8% 9.1% 11.4% 

LEL - ET 0% 0% 0% 3.7% 3.7% 1.4% 1.4% 0% 3.7% 1.4% 

Income Tax Rates and Allowances 
These are the income tax allowances for the 2009-10 tax year: 

Income Tax Personal Allowance £6,475 

Personal Allowance for people aged 65-74 £9,490 

Personal Allowance or people aged 75 and over £9,640 

Married Couples Allowance (aged less than 75 and born before 6th April 
1935) 

£6,965 

Blind person’s allowance £1,890 

These are the income tax bandwidths for the 2009-10 tax year: 

 £ per year 

Starting rate: 10% - 

Basic rate: 20% 0 - 37,400 

Higher rate: 40%  37401 + 
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Amended P45 Design 
HMRC has changed the design of the P45 form effective 6 April 2009 and has also introduced a 
new plain-paper form for employers to give to their employee if they submit their P45 Part 1 
online. HMRC refer to the plain-paper form as the P45(Online) form. 

From 6 April 2009, all employers must use the new P45 design, which includes boxes for 
additional information that the employer must provide.  Before 6 April 2009, employers can 
choose to use either the old stationery or the new stationery. 

In addition, all employers with 50 or more employees must submit P45 Part 1 and P45 Part 3 
forms to HMRC online. From 6 April 2009, paper returns from these employers will not be 
accepted by HMRC. 

HMRC expect that employers with fewer than 50 employees will have to submit the P45 Part 1 
and P45 Part 3 online from 6 April 2011. 

There are a number of changes to the P45 design. These are the notable changes included on 
the P45 form: 

Change Note 

Box for the employee’s gender This new box must be used if the new form is 
used 

Box for the employee’s date of birth This new box must be used if the new form is 
used 

The employee’s works number or payroll 
number, and department share the same 
box 

The department was previously printed in a 
separate box 

Dates are now separated into individual 
boxes for the day, month, and year 

Previously only some P45 designs formatted 
dates in this way 

Numbers for some boxes have changed Some of the box numbers on the P45 have 
changed. For example, the employee’s address is 
changing from box 11 to box 12 

Important: Plain-paper P45s can only be supplied to an employee if the P45 Part 1 (the 
copy for HMRC) is filed online. The paper must be white A4 sized and 80 gsm (grams per 
square metre) quality. 

New P46 (Pen) Return 
From 6 April 2009, the P160 form or PENNOT online submission will be replaced by the P46 
(Pen). The P160 form or the PENNOT online submission are currently used by pension 
providers and employers that run their own pension or annuity schemes to inform HMRC when 
someone starts their retirement. 

Employers with 50 or more employees that before 6 April 2009 submitted P160 forms on paper 
or PENNOT returns online, must instead submit a P46 (Pen) online. HMRC expect that 
employers with fewer than 50 employees will have to submit the P46 (Pen) online from 6 April 
2011.  

The information on the P46 (Pen) form is similar to the P45 and P46 forms, but it also includes 
the following pension-specific boxes:  

Box Note 

Annual Pension  Annual Pension when retirement started 

Recently Bereaved indicator  Ticked if the reason a person is being paid a pension is because 
their spouse or civil partner has died. 

Note: At the time of writing, HMRC sometimes refer to pension notifications in a 
generalised way, saying for example ‘sending P45s, P46s, or similar pension information 
online …’. You may find that HMRC still refer to pension notifications in this way rather than 
saying ‘P46 (Pen)’. 
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New P46 (Expat) Return 
From 6 April 2009, if an employee who works for an overseas employer is seconded to work in 
the United Kingdom, form P46 (Expat) must be submitted to HMRC when they start work.  

HMRC define a seconded employee as someone who is:  

• Working wholly or partly in the UK for a UK employer on assignment whilst remaining 
employed by an overseas employer 

• Working wholly or partly in the UK at a recognised branch of their overseas employer’s 
business 

• Included by an employer in a dedicated expatriate scheme 
• Included by an employer in an expatriate modified PAYE scheme. 

The information on the P46 (Expat) form is similar to the P46 form, but it also includes the 
following boxes:  

Box Note 

EEA/Commonwealth citizen An indicator for citizens of the European Economic Area or 
Commonwealth 

Employee’s present 
circumstances 

A description of the employee’s present circumstances: 

• Whether they intend to live in the UK for more than six months 
• Whether they intend to live in the UK for less than six months 
• Whether they will be working for the employer both inside and 

outside the UK but will be living abroad. 

Digital Receipts (in-year online submissions) 
From 6 April 2009, software products that submit in-year returns online must be able to receive 
digital receipts from HMRC. Digital receipts, also called the HMRCMark, are electronic 
responses that are sent by HMRC after online returns have been submitted. The HMRCMark is 
also sometimes referred to as the IRMark. 

In particular, a digital receipt provides the following information:  

• That a submission has been accepted by HMRC 
• That a submission has been validated by HMRC  
• A unique HMRCMark identification code  
• A message about the communication sent. 

If there is a civil dispute between HMRC and an employer about an online submission, the 
submission that HMRC has is presumed to be correct unless the employer can prove otherwise. 
A digital receipt provides the evidence of the online submission sent by the employer. 

Changes to XML messages (in-year and year end submissions) 

In-year Returns 

HMRC has tightened up the validations of in-year online returns for the 2009-10 tax year. In 
particular, the following have changed:  

• All P45 and P46 submissions must now include the employee’s date of birth 
• P45 Part 3 and P46 returns must now include two address lines. 

Year end Returns 

The content of the XML message for returns for the 2008-09 year end has changed: 

• The tax year part of the message has changed 07/08 to 08/09 
• The year end date part of the message has changed to 05/04/2009. 
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Discontinued HMRC form SSP1 (L)  
HMRC has discontinued the use of the SSP1 (L) form. The form was previously used to link 
employee’s periods of sickness when they were employed by different employers. 

If an employee was ill after starting work for a new employer, and had been paid SSP by their 
previous employer within the eight week (56 day) linking period for SSP, the new employer was 
required to consider the earlier period of sickness. This was important so that payment of SSP 
stopped when the 28-week maximum was reached.  

The previous employer was previously required to issue SSP1 (L) form if the employee asked 
for one when they left. This is no longer the case. 
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Software Calculations of SAP and SPP - Adopt 
These are new mandatory elements of the HMRC Payroll Standard for software products. 

From 6 April 2009, to comply with the HMRC Payroll Standard, software products must be able 
to calculate Statutory Adoption Pay (SAP) and Statutory Paternity Pay for adoption (SPP - 
Adopt), and provide the necessary reports.  In previous tax years, software products had only to 
be able to keep records of SAP and SPP - Adopt, and provide the necessary reports.  

• SAP is a legal entitlement to a certain amount of pay to help any employee who is 
adopting a child, to take time off work around the time the child is placed with them. It is 
available to individuals adopting a child on their own, or one member of a couple 
adopting a child together. It is paid for up to 39 weeks. 

• SPP - Adopt is a legal entitlement to a certain amount of pay to help an employee take 
time off after a child is placed with the adopter. It is available to someone adopting a child 
with their partner, or the partner of someone adopting a child on their own. It is paid for 
up to two weeks. 

SAP and SPP are calculated as the lower of the standard rate, or 90% of the employee’s 
average weekly earnings. 

The following terms are used when adopting a child: 
Adopter  Means the person(s) who are going to adopt a child. They may be going to 

adopt a child on their own, or with their partner. 

Matched/Matching  Means the adoption agency has decided that a person is suitable to adopt a 
particular child. The adoptive parent(s) may be given a ‘matching certificate’ 
letter from the agency. 

Placed  Means the child starts living with the person permanently with a view to 
being formally adopted in the future. They may have stayed with them 
before this date. 

The employer must consider the following points when an employee advises them that they 
wish to claim SAP or SPP - Adopt:  

• Where possible, employees should tell their employers 28 days before they want to start 
being paid SAP or SPP - Adopt.  

• The employee’s average earnings must be at or above the Lower Earnings Limit (LEL) in 
the eight weeks before the date that the adoption agency had told the adopter they had 
been matched with a child.  

• The adopter must be employed by the employer continuously for at least 26 weeks into 
the week that the adoption agency told the adopter they had been matched with a child.  

• For SPP - Adopt only, the adopter must continue to work for the employer right up until 
the date the child is placed with them.  

Tip: The HMRC Employer Helpbook E16 (2008) includes details of SAP and SPP - Adopt 
plus pointers to more information.  
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 Software Changes in Capital Gold Payroll (3.80) 

Upper Accrual Point Threshold 
The Upper Accrual Point (UAP) is a new National Insurance threshold that is positioned 
between the current Earnings Threshold and the Upper Earnings Limit threshold. From 6 April 
2009, this new threshold is used to calculate National Insurance contributions (NICs) along with 
the existing thresholds. The calculation of Contracted Out Money Purchase (COMP) payments 
for employees who are members of a COMP pension scheme is also affected. 

The P11 Deductions Working sheet and other HMRC forms have changed to capture earnings 
above the UAP to the Upper Earnings Level (UEL). In effect the old Earnings Threshold to 
Upper Earnings Limit column has split into two columns:  

• Band 1d - Earnings above the UAP up to and including the Upper Earnings Level (UEL) 

• Band 1c - Earnings above the Earnings Threshold (ET) up to and including the UAP. 
The software changes affect the following operations in Capital Gold Payroll from the first period 
of the new tax year (2009-10):  

• Statutory NI thresholds and bandwidths 
• Calculation and reporting of NI earnings values and pensions 
• Maintenance of employees’ NI earnings figures including NI adjustments. 

Note: The software changes to these areas do not affect the 2008-09 tax year. 

Along with the calculation amendments needed, there are numerous screens and report 
changes to accommodate this change. These changes are all effective in the 2009-10 tax year. 

National Insurance Parameters 

The NI parameters are part of the system. They are set to the rates and thresholds for the 
2008-09 tax year until a year end restart is done. These parameters do not include the new 
UAP threshold. When the year end restart is done, the NI parameters are set to those for the 
2009-10 tax year. 

File > Import Data 

A new field - NI Earnings 1d To-Date - has been added to the Fields tab on the Data Import 
form. This is for year-to-date earnings in the UAP to the UEL bandwidth.  

The old field - NI Earnings 1c To-Date - is now used for year-to-date earnings in the Earnings 
Threshold (ET) to the UAP bandwidth.  

New field - NI Earnings 1d To-Date – for earnings from the UAP to the UEL this period 
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File > Export Data  

A new field - NI Earnings 1d To-Date - has been added to the Fields tab on the Data Export 
form. This is for year-to-date earnings in the UAP to the UEL bandwidth. The old field - NI 
Earnings 1c To-Date - is now used for earnings from the Earnings Threshold (ET) to the UAP.  

New field - NI Earnings 1d To-Date – for earnings from the UAP to the UEL to date 

File > Print Tax/NI Rates 
The UAP is included on the report in the NI Earnings Bands section. A new column has also 
been added to the NI Rates section report called UAP to UEL.  The column holds the 
percentage for employees’ and employer’s contributions. 

Company > Alter Payments/Deductions 
Pension calculations are based on earnings up to the UAP. If a Weekly UPPER limit is used for 
calculations of COMP deductions, the limit is the UAP threshold instead of the UEL. The 
LOWER limit has not changed. 

Payments & Deductions form with UPPER limit applied 
The Upper option on the Range Settings form has been renamed to NI Upper Accrual Point.  
This can be used if a payment or deduction has a Range check applied to it.  

  
Settings for payments & deductions form Range Settings  (2008-09 tax year) Range Settings  (2009-10  tax year) 
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If the Capital Gold Payroll Plus Pack is used, custom formulas can be created to calculate 
payments and deductions. These changes affect custom formulas:  

• A new option is available in the variables list called NI Earnings 1d This Period. This is 
the NI earnings value up to the UAP threshold. 

• The NI Upper Limit variable now uses the UAP threshold instead of the UEL. 

 
Formula Definition - new variable for Settings for NI Earnings 1d This Period Formula Definition -NI Upper Limit now uses the UAP threshold 

Employee > Add & Alter Current Employee 

The To-Date tab on the Employee form includes a new box that holds the NI Earnings 1d This 
Period. This is the earnings value above the UAP up to and including the UEL. 

After a payroll is run the field is disabled.  

A new History form displays the current period and year-to-date details for the NI Earnings 1d 
This Period box. 

 

Employee details To-Date tab - new box for NI Earnings 1d This Period New History form  for NI Earnings 1d This Period 
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Employee > Overrule Figures > NI Adjustment 

A new column is displayed on the NI Adjustment form to hold the NI Earnings 1d value for each 
pay period.  

The NI Adjustment report and NI Summary view also display the information. 

 

 

NI Adjustment form - new column for NI Earnings 1d values NI Summary View -  new column for NI Earnings 1d values 

Payroll > Do/Redo Payroll 

The calculation of National Insurance contributions for employees for the 2009-10 tax year 
includes the new UAP threshold. The value is then added to the employee’s to-date totals along 
with the values for the other NI Earnings thresholds. 

The Pay Preview form also now displays the NI Earnings 1d value.  

Pay Preview form - new NI Earnings 1d value 

Payroll > Undo Payroll 

The Undo Payroll command removes the NI Earnings 1d value for the current pay period along 
with the NI Earnings 1a, NI Earnings 1b, and NI Earnings 1c values. The values are then 
subtracted from the Employee’s year-to-date totals. 

Reports > Quick Report Writer 

The fields NI Earnings 1d TP and NI Earnings 1d YTD have been added to the Quick Report 
Writer.  
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Reports 

These reports have been updated to include the NI Earnings 1d values:  

Print Summaries > Payroll 
Summary 

A new column - Earnings 1d - is displayed between Earnings 1c and 
Earnings 1b + 1c on the report.  This report applies to the 2009-10 tax 
year so is not installed automatically. 

Print Multi Period Reports > 
HMRC Audit File Generation 

A new column - Earnings above the UAP - is displayed between 
Earnings above the ET and Earnings above the UEL This Period   

Print Multi Period Reports > 
History Summary 

A new column - Earnings 1d - is displayed on Page 2 between Earnings 
1c and Earnings 1b + 1c. This report applies to the 2009-10 tax year so 
is not installed automatically. 

Print Multi Period Reports > 
P11 Working Sheet 

A new column - Earnings 1d - is displayed after Earnings 1c. Other 
columns have been renamed to accommodate the new column. A new 
field for Earnings 1d values is also displayed in the summary section 
after ‘Earnings 1c’.   

Year End Discrepancies 
report 

A new field - NI Earnings 1d - has been added to the report.  

File > Print Tax/NI rates A new column - NI Earnings Bands UAP is displayed on the report 
between NI Earnings Bands ET and NI Earnings Bands UEL. A new 
column has also been added to the NI Rates section called UAP to UEL 
to display the percentages for employee and employer contributions. 
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P14/P60 (End of Year Summary) & P35 (Employers Annual Return)  
There are no software changes for P14/P60 and P35 end of year returns for the 2008-09 
income tax year because HMRC has not changed the forms’ layout and design. However if the 
returns are sent on paper, employers must use the correct version for the year. 

New P46 (Pen) Return 
The software changes for the P46 (Pen) return affect the Reports > Print Other Reports 
command, and Online Services in Capital Gold Payroll. These changes are relevant from the 
start of the 2009-10 tax year.   

Employee > Add/Alter Employee > Online Services 
A new option - P46 (Pen) - has been added to the Online Services form to capture details of 
someone who is starting to be paid a pension. The details are included on the P46 (Pen) return 
when it is submitted online to HMRC. 

 
Employee > Add/Alter Employee > Online Services form 
The Date Pension Started must be provided before the P46 (Pen) return is submitted to HMRC. 

Reports > Print Other Reports  
To cater for employers that submit in-year returns to HMRC on printed forms, a new report is 
available - P46(Pen) Report. The report must be selected from the Reports Library before it can 
be used. 

 
Reports > Print Other Reports form 
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Amended P45 Design 
Changes were made to the P45 reports in Capital Gold Payroll (3.78) and are also in Capital 
Gold Payroll (3.80). The changes are reiterated for those customers who did not receive Capital 
Gold Payroll (3.78). 

Employers who file online are able to print the P45 part 1A to part 3 on plain A4 paper instead 
of using HMRC’s pre-printed stationery. To cater for employers who file online and choose to 
use the plain paper return, there is a new P45 (Online) Report in the Reports > Library Selection 
> Miscellaneous command.  

To cater for employers who choose to use HMRC’s pre-printed form, the P45 Pre-Printed Laser 
report has also been amended to fit HMRC’s new form.  

The report called P45 Plain Paper report is no longer available. The new P45 (Online) Report 
can now be used for viewing figures but it can only be issued to the employee if the P45 has 
been filed online. 

Reports > Library Selection > Select Miscellaneous Report 
To summarise the changes to the P45 reports:  

• A new report  - the P45 (Online) Report - is available to print the P45 on plain paper. This 
prints the P45 part 1A to part 3 on plain A4 paper instead of using HMRC’s pre-printed 
stationery. The return must be printed in black ink. 

• The employee’s gender is now included. 

• The employee’s date of birth is now included. 

• The employee’s department and reference number (works number) are included in the 
same box. 

• Dates are now printed in individual boxes for the day, month, and year. 

• Decimal points are now printed in the values. Decimal points were previously included on 
the stationery design. 

Important: If the old P45 Plain Paper report was previously selected from the Reports 
Library, do not use it in the 2009-10 tax year. Use the P45 (Online) Report instead. 
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Other Software Changes 
Tax Rates Effective date shown on Status Bar 

It is now easier to see which tax bands are being used. The tax bands have been added to the 
status bar.  

 

Income Tax Bands Used Automatically  

The income tax bands now change automatically based on the Pay Date entered in the payroll. 
The bands do not need to be changed manually.   

Important: This does not negate the necessity for software updates.  

Adjustable Printer Margins - Payslips and P60s  

A new button is available when printing payslips and P14/P60’s. This allows the margins to be 
adjusted before a payslip or P60 is printed. This feature is most useful for payslips which can be 
printed on dot matrix printers using pre- printed stationery. P14/P60’s can be printed on laser 
printers only. 

Payslips and P60 Printer Margins form 

Note: The new feature is only available for Payslips and P14/P60’s. The margins that are 
entered affect both reports. 

Discontinued HMRC form SSP1 (L) 
 

HMRC has discontinued the use of the SSP1 (L) form. The form was previously used to link 
employee’s periods of sickness when they were employed by different employers. All messages 
and warning prompts regarding the SSP1 (L) are no longer displayed when printing P45 
returns. 

Bank Reference 1 box Renamed to Bank Ref 1 (Bobs/Autopay) 

In the Employee > Add New Employee and Alter Current Employee forms, the Bank Reference 
1 box on the Bank tab has been renamed to Bank Ref 1 (Bobs/Autopay).   

 
Renamed box on the Employee form 
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SPP (Birth) Eligibility Period Lengthened by 1 Day 

Eligibility for SPP now starts the day after the child’s birth, not the birthday itself. The 56 days 
eligibility period now begins the day after the birth date.  
 

Printing Reports designed for Different Tax Years 

Previously the only report in Capital Gold Payroll that had separate designs and layouts for the 
previous tax year and the current tax year, and could be chosen by the user, was the P11 
Working Sheet report. It is now possible to print report designs for the previous tax year or the 
current tax year for the Employer Annual Returns (P14/P60s) and Payroll Summary report.  

The affected reports are: 

• Payroll Summary Report 

• Employer Annual Return P14/P60 

• P11 Working Sheet. 

The user does not need to select the report for the tax year; it is selected automatically by 
Capital Gold Payroll. When the tax year is selected on the Print Report criteria form, Capital 
Gold Payroll chooses the report for the year.  

 
The tax year box on the Print Report 
criteria form. 

It is only possible to print using the designs and layout for the previous tax year and the current 
tax year. 

P11 Working Sheet 

This also means that there is only one P11 Working Sheet report in the Report Library. 
Previously there were separate reports for the 2007 - 2008 and 2008-09 tax years and the user 
chose the report from the Report library. Now this is not necessary; Capital Gold Payroll 
chooses the report based on the tax year selected. 

The report has been updated for the 2009-10 tax year to include the NI Earnings 1d band. 

Separate reports for selection in the Report Library (earlier releases) One P11 Working Sheet report for selection (Capital Gold Payroll 3.80)  

New ‘Previous Year’ Reports Folder 

Until now, all Capital Gold Payroll reports have been installed in the Reports folder beneath the 
Capital Gold Payroll folder (by default the installation location is c:\Program 
Files\Pegasus\Gold Payroll). During the installation of Capital Gold Payroll (3.80), a 
new folder called Previous Year is created in the Reports folder. Any reports that can be printed 
for the previous year are kept in this folder.  

By default, the location is c:\Program Files\Pegasus\Gold Payroll\Reports 
\Previous Year. 
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Year end Restart - Automatic Tax Code Update 

During a Year end Restart, employees’ tax codes are now automatically updated with the 
budget amendments for the next tax year. This can affect any employee with L, P, or Y suffix 
tax codes but it depends on whether all these codes are affected by changes announced by 
HMRC.  

For the 2009-10 tax year, the L suffix tax codes are automatically updated to 647L during the 
Year end Restart. The budget amendments are completed when the tax year is advanced to the 
new tax year.  

This message is displayed during the Year end Restart to advise that tax codes will be adjusted 
in line with amendments announced in the budget. 

The current tax year for <company name> is now 2009/10. Employee tax 
codes have been updated according to Budget requirements. 

Important: The Company > Budget Amendments command is still available but this must 
not be run unless HMRC issue tax code change notifications on PAYE Coding Notices 
during the tax year. 

 

Multi Period Payment & Deduction Summary  

The period amount and period number has been added to this summary report when the All 
Payments option is selected. 

 
All Payments option on the Print Report criteria form  
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Upgrade Procedure for Capital Gold Payroll and Online Filing 
Manager 

The software can be installed in any pay period before the end of the 2008-09 tax year. 
However, it must be installed before processing the 2008-09 year end.  

Capital Gold Payroll (3.77) or later should already be installed before upgrading. Use the Help > 
About command to check the version number installed. 

STEP 1: Before You Begin 
You should aim to carry out the software upgrade after a full payroll cycle and before starting 
any further processing. That is, having used the Payroll > Do/Redo Payroll command for each 
company. Aim to install the software before processing starts in the new pay period.  

STEP 2: Upgrading the Software 
Warning: Before the software is installed, backup the Capital Gold Payroll data files using 
the File > Back-up & Restore > Back-up Company Data command.  

Before commencing with the upgrade, make sure that all applications are closed. 

To Upgrade to Capital Gold Payroll (3.80) 

1. Insert the Capital Gold Payroll CD into the computer. Provided the computer is set up to 
use the Autorun feature, the launch screen should appear automatically.  

If the launch screen does not appear, click the Windows Start button, and then click Run. 
In the Open box, type d:launch.exe (where d is the letter that identifies the CD drive) and 
then click OK. The Launch screen is displayed.  

2. Click Print Release and Upgrade Guide to open the Capital Gold Payroll Release and 
Upgrade Guide to familiarise yourself with the changes in Capital Gold Payroll. You are 
warned if the guide is not opened before the installation starts. 

3. Click the Print Installation Guide link to familiarise yourself with the instructions to 
upgrade the software or install it for the first time. You must read the guide to ensure you 
understand the necessary steps to upgrade. Follow the instructions in the relevant section 
of the guide - use the bookmarks on the left of the guide to find the section you need. 
Installation Guide 
bookmarks 

Section in Installation Guide Print and follow if … 

Installing Capital Gold Payroll 
for the First Time 

Capital Gold Payroll is being 
installed for the first time on the 
computer 

Upgrade Existing Installations Capital Gold Payroll is already 
installed on the computer and 
needs to be upgraded. 

 

You must open the guide to be able to continue with the installation. 

4. Click Install Capital Gold Payroll when you have familiarised yourself with the instructions 
in the Installation Guide. Follow the instructions in the relevant section of the guide. 

Note: A Capital Gold Payroll upgrade does not need to be registered again before it is 
used. 
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STEP 3: Checking the Upgrade was Successful 
Having upgraded to Capital Gold Payroll (3.80) and logged on, from the Help menu, choose 
About Capital Gold Payroll. Under Licence Details the dialog box should indicate Latest Tax & 
NI Rates Correct at April 2009 (Not Using). The legend Not Using will disappear once the new 
Tax year begins. 

If this is not shown, the upgrade was not successful. Check that you upgraded the programs in 
the correct directory or folder and that you have logged on to Capital Gold Payroll (3.80) and try 
again. If this is still not successful, you will need to contact your support provider for advice. 

STEP 4: Installing Online Filing Manager (2.70) 
Install Online Filing Manager (2.70) using the instructions in the product’s Installation Guide. A 
link to the guide is on the launch screen. The guide is on the Capital Gold Payroll CD in the 
Online Filing Manager\Documents folder. 

To Obtain the Installation Guide 

1. If the Capital Gold Payroll CD is still in the computer, go to step 3. Otherwise, insert the CD 
into the computer. Provided the computer is set up to use the Autorun feature, the launch 
screen should appear automatically.  

2. If the launch screen does not appear, click the Windows Start button, and then click Run. 
In the Open box, type d:launch.exe (where d is the letter that identifies the CD drive) and 
then click OK. The Launch screen is displayed. 

3. Click the Print OFM Installation Guide link to familiarise yourself with the instructions to 
upgrade the software or install it for the first time. You must read the guide to ensure you 
understand the necessary steps to upgrade. Follow the instructions in the relevant section - 
use the bookmarks on the left of the guide to find the section you need. 
Installation Guide  
bookmarks 

Section in Installation 
Guide 

Print and follow if … 

Installing Online Filing 
Manager and Prerequisites 

Online Filing Manager is 
being installed for the first 
time on the computer 

Upgrading from earlier 
versions of Online Filing 
Manager (2.60 or later) 

Online Filing Manager is 
already installed on the 
computer and needs to be 
upgraded. 

 

 

4. Click Install Online Filing Manager when you have familiarised yourself with the 
instructions in the Installation Guide. Follow the instructions in the relevant section of the 
guide. 
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 Doing the 2008-09 Year End in Capital Gold Payroll 

Here is a reminder of the tasks to carry out at the end of the 2008-09 tax year, for each of the 
Capital Gold Payroll companies.  

The following procedure applies only when the current period is the last period in the tax year. 

Note: Before completing the year end, backup the Capital Gold Payroll data files using the 
File > Back-up & Restore > Back-up Company Data command. Follow the instructions on 
the screen.  

STEP 5: Doing the 2008-09 Year End 
Here is a summary of how to start the year-end process in Capital Gold Payroll. You should 
repeat the steps for each company on your payroll. 

Installing End of Year Reports 

Because changes have not been made to year end report layouts, they do not need installing 
from the reports library if they are already installed. The existing reports can be used.  

Printing the Year End Reports 

You are now ready to print year end forms for the 2008-09 tax year. 

Printing Year End Returns on Printed Stationery 

1. Select the Reports > Year to-date Summary command and print the following:  

i. The Year to Date Summaries report for the entire payroll. This prints a substitute for 
the official P35(CS) report. The P35(CS) report must be attached to a signed and 
completed P35 before sending it to the HMRC. 

ii. The P35 Summary report.  

2. Select the Reports > Year end Forms and print the P14/P60 forms for the entire payroll. 
Make sure your printer is loaded with forms for the 2008-09 tax year. 

Submitting Year End Returns on Floppy Disk 

3. Ensure the Output To option in the Company > Company Details > Tax tab > Year end 
Returns section is set to the destination drive and path you wish to use when generating 
the year end returns for submission on floppy disk.  

4. Select the Reports > Year end Floppy Disk command. 

5. Use the Reports > Year end Forms command to print a P60 for each employee. 

Submitting Year End Returns Online using Online Filing Manager  

6. Ensure the Output To option in the Company > Company Details > Tax tab > Year end 
Returns section is set to ISFP File.  

7. Select the Reports > Create ISFP File command. This creates a .NET file (the file that 
includes employees’ year end details) for the company. The file is created in the main 
Capital Gold Payroll folder, which by default is either C:\Program 
Files\Pegasus\Gold Payroll or C:\Pegasus\Gold Payroll on Windows 
Vista. The file has a naming convention of *_PAYEOY_*.NET, where * is the company 
number, for example; 1_PAYEOY_1.NET is for company 0001.  

8. Use the Reports > Year end Forms command to print a P60 for each employee. 

Important: You must use the Create ISFP File command on the Reports menu to create 
the correct file to submit to the Government Gateway using Online Filing Manager. You 
must also install Online Filing Manager (2.70) before submitting returns to the Government 
Gateway. See the product’s Installation Guide for installation instructions and the last 
section of this guide for details of the software changes in Online Filing Manager (2.70). 

D
O

IN
G

 TH
E YEA

R
 EN

D
  



 

Capital Gold Payroll (3.80) 
Payroll Release and Upgrade Guide: 
2008-09 Year End & 2009-10 Tax Year Page 25 of 31 

 

Payroll Release and Upgrade Guide: 
2008-09 Year End & 2009-10 Tax Year 

 Starting the 2009-10 Tax Year in Capital Gold Payroll 

Before using Capital Gold Payroll (3.80) in the 2009-10 tax year, you need to adjust records and 
clear totals for the 2008-09 tax year. 

You must back up the Capital Gold Payroll data files before starting the new Tax year. 

STEP 6: Starting the New Tax Year 
Here is a summary of how to start the new tax year in Capital Gold Payroll. Take a backup of 
each company’s data files before you start. 

Year end Restart 

The information for the 2008-09 tax year for each company on the payroll needs to be cleared. 
The Year end Restart command clears all employee year-to-date totals and removes any 
employees who have left during the Tax year. 

To Perform the Year end Restart 

1. Select the Company > Year end Restart command. To confirm you want to continue, read 
the messages on the screen and, to continue, click Yes to the prompts. A backup of the 
2008-09 data is copied automatically to a folder called LastYear in the main Capital Gold 
Payroll folder, which by default is C:\Program Files\Pegasus\Gold 
Payroll\LastYear or C:\Pegasus\Gold Payroll\LastYear on Windows Vista. 

2. The Year end Restart form is displayed. In the column to the right of the Pay Rate and 
Payment & Deduction descriptions, click to select the totals to clear down. Many are 
already selected by default. Clicking again clears the selection if the corresponding item 
should not be cleared down. Then click OK. 

3. History records for pay history, diary entries, and costing records can be deleted during 
the year end restart process. Click on the drop-down lists to alter the year’s history to be 
cleared down. Then click OK. 

4. At the prompt, click Yes to confirm that the new Tax year is 2009-10. 

New Employee Tax Codes 

During a Year end Restart, employees’ tax codes are now automatically updated with the 
budget amendments for the next tax year. This can affect any employee with L, P, or Y suffix 
tax codes but it depends on whether all these codes are affected by changes announced by 
HMRC.  

V suffix tax codes will not be used after the 2008-09 tax year. Employees with V suffix tax codes 
will receive a notice of coding before 6 April 2009 with details of their new code. 

Important: You must not run the Budget Amendments command. If you do, the tax 
codes will be updated again. 

Checking Employee Details 

You may need to review and amend employee details too. For example, changes to an 
individual’s tax or NI status or company director status must be made in Capital Gold Payroll to 
the employee records. 

New employees starting at the beginning of the new Tax year must have new records set up 
before the first payroll period is processed. 

Amended tax code notifications may also have been received for some employees on PAYE 
Coding Notices. These changes must be applied before you process your first payroll period. 
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To Maintain Employee Records 

1. Select the Employee menu: 

• If you want to create a new employee record, click Add New Employee. 

• If you want to amend an existing employee record, click Alter Current Employee. 

2. Make the changes or additions required. 

Defining the Small Employers Relief for SMP/SPP/SAP 

For the purpose of Small Employers Relief (SER), HMRC’s definition of a small employer for the 
2009-10 Tax year is one who paid, or was liable to pay, a total of £45,000 or less gross NI 
during the 2008-09 tax year. If your company qualifies as a small employer, follow these 
instructions to update Capital Gold Payroll. If your company does not qualify as a small 
employer, skip this step. 

To Define the Small Employers Relief Threshold 

1. Select the Company > Alter Company Options. The Company Options form is displayed.  
2. On the Company tab, click to select the Small Employers Relief option, then click OK. 
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 2009-10 PAYE, NI and Statutory Rates in Capital Gold Payroll 

Capital Gold Payroll has been updated to cater for the new rates for the 2009-10 tax year.  

For details about the changes to rates and ranges, refer to the Overview of Statutory Changes 
section of this guide and the various employer guides as listed at the end of this guide, which 
will have been supplied by HMRC as part of the Employer’s Annual Pack. PA
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 Software Changes in Online Filing Manager (2.70) 

Software changes for the 2008-09 year end are included in Online Filing Manager (2.70), which 
works with Capital Gold Payroll (3.80). 

Instructions to install Online Filing Manager are detailed in the product’s Installation Guide in the 
Online Filing Manager\Documents folder on the Capital Gold Payroll CD.  

Changes to the XML File Content 
The format of the XML file used by Online Filing Manager to file Employer Annual Returns 
online has changed:  

• The tax year has been changed to 2008-09 

• The year end date has been changed to 5 April 2009. 

Changes to the PAYE End of Year Wizard 
Various changes have been made to reflect the changes to the P35 Employer Annual Return, in 
particular: 
During Step 3 (Additional Information)  

• The maximum value allowed in Box 26 (tax-free incentive payment) has increased from 
£650 to £750.  

Important: The EYRS file that is created in Capital Gold Payroll for the submission of end 
of year returns on floppy disk must not be used to submit returns to the Government 
Gateway. The .NET file must be used. 
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 Where to Find More Information 

General PAYE and NIC Issues 
Employers can get help on PAYE and NIC issues from their PAYE Tax Office, or a Tax Enquiry 
Centre (quoting their PAYE reference number) for PAYE matters; the National Insurance 
Contributions Office via the local Social Security office for National Insurance matters; or the 
Employer’s Helpline by phoning 0845 7 143 143 (calls are charged at the local rate). 

Guidance on the Statutory Payroll Changes 
HMRC provides information on legislative changes in these employer guides, available from 
either the Employer’s Orderline on 0845 7 646 646 (calls are charged at the local rate), or from 
your nearest HMRC office.  

E10   Finishing the Tax Year 

E11   Starting the Tax Year 

E12   PAYE and NIC Rates and Limits 

E13   Day-to-Day Payroll 

E14   Sick Pay 

E15   Maternity Pay 

E16   Adoption Pay 

E19  Paternity Pay 

CWG2  Employer’s Further Guide to PAYE and NICs 

CA33   Class 1A NI Contributions on Car and Fuel Benefits  

CWG5  Class 1A NI Contributions on Benefits in Kind 

CA44  National Insurance for Company Directors 

 CA51/52 Submitting Year End Returns on Magnetic Media.  

Note: Magnetic Media is not classed as a means of filing Employer Annual Returns online. 
Employers with fewer than 50 employees do not have to file Employer Annual Returns 
online for the 2009-2010 tax year. However, they can get tax-free incentives for filing online 
early. More information about tax-free payments can be found on the HMRC web site. 

Links to Useful Web Sites 
The following web site links might be helpful in relation to payroll matters. 

HMRC  www.hmrc.gov.uk/ 

HMRC Employer Orderline Download area www.hmrc.gov.uk/employers/emp-form.htm 

HMRC PAYE Online services  www.hmrc.gov.uk/payeonline/ 

Department for Work and Pensions  (DWP) www.dwp.gov.uk/ 

The institute of Payroll and Pensions 
Professionals  

www.payrollprofession.org/ 

The Pensions Regulator  www.thepensionsregulator.gov.uk/ 

The Government Gateway for Internet 
Submissions  

www.gateway.gov.uk/ 

Jobcentre Plus (DWP)  www.jobcentreplus.gov.uk/ 

Pegasus Online Filing Guide  www.pegasus.co.uk/onlinefiling/ 

Note: Links may be subject to change since the publication of this guide. 
 

http://www.hmrc.gov.uk/�
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http://www.hmrc.gov.uk/payeonline�
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http://www.payrollprofession.org/�
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http://www.pegasus.co.uk/content.asp?PageId=1500�
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 Glossary of Terms 

The following list explains some of the terms and abbreviations used in this guide: 

General 
HMRC Her Majesty’s Revenue and Customs 

Online Services HMRC service used by Pegasus products to submit employer and employee 
returns online 

XML Extensible Markup Language - used to hold employer and employee details for 
filing with HMRC using Online Services 

In-year returns HMRC returns that are submitted throughout the tax year, for example forms 
P45 Part 1, P45 Part 3, P46, P46(Pen) and P46(Expat) 

Year end returns Employer Annual Returns that are submitted to HMRC at the end of the tax 
year, for example forms P14 and P35 

Statutory Payments  
S2P State Second Pension 

SAP Statutory Adoption Pay 

SMP Statutory Maternity Pay 

SPP - Birth  Statutory Paternity Pay for New Birth 

SPP - Adopt Statutory Paternity Pay for Adoption 

SSP Statutory Sick Pay 

Pay, Tax and National Insurance 
Income tax Year A tax year is a period starting on 6 April in one year and ending on 5 April in the 

following year. For example, the 2008-09 tax year starts on 6 April 2008 and 
ends on 5 April 2009. 

PAYE Pay As You Earn  

NIC National Insurance Contributions 

NICO National Insurance Contributions Office 

NINO National Insurance Number 

UEL The Upper Earnings Limit for calculating NICs 

UAP The Upper Accrual Point for calculating NICs 

ET The Earnings Threshold for calculating NICs 

LEL The Lower Earnings Limit for calculating NICs 
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 Key Dates for Your Payroll Diary 

 
19 April 2009  The last date for any 2008-09 PAYE/NIC payments to reach the Accounts 

Office. Interest is chargeable on any payments received after this date 

19 May 2009  The last date for the 2008-09 P14s or substitutes and P35s to reach the 
HMRC Office (including electronic submissions via the Internet or magnetic 
media). Penalties are chargeable on any forms received after this date. 

31 May 2009  The last date for giving a 2008-09 form P60 to each relevant employee 

6 July 2009  The last date for your 2008-09 form P9D and form P11D or substitutes, to 
reach the Inspector of Taxes and for giving a copy of the 2008-09 form P9D-
P11D or equivalent information to each relevant employee 

19 July 2009  The date for payment of any 2008-09 Class 1A NICs on employee benefits 

19th of each 
month/quarter 

The last date for sending your monthly/quarterly PAYE and NIC payments to 
the Accounts Office unless paid electronically 

22nd of each 
month/quarter 

Starting with the first monthly payment (due 22 May 2009 ), the last date for 
sending your monthly/quarterly PAYE and NIC payments to the Accounts 
Office but only if paid electronically 

Note: Large employers (250 or more employees) must make monthly 
PAYE and NIC payments electronically. 

 

Tip: The employer diary on the HMRC web site includes the dates employers need to 
know for filing returns and paying income tax and National Insurance. To see the diary, go 
to www.hmrc.gov.uk/employers, and select Employer Diary from under ‘quick links’. 

 

http://www.hmrc.gov.uk/employers�

	Introduction
	When to Carry Out the Software Upgrade
	Installation and Upgrade Instructions
	Adobe Reader (9.00)
	Feedback

	Quick Overview of Legislative and Other Changes
	Legislation and other requirements
	HMRC Payroll Standard and the Pensioner Payroll Standard

	More Detail of the Legislative and Other Changes
	Upper Accrual Point NIC threshold
	Income Tax Rates and Allowances
	New P46 (Pen) Return
	Digital Receipts (in-year online submissions)
	Changes to XML messages (in-year and year end submissions)

	Software Changes in Capital Gold Payroll (3.80)
	Upper Accrual Point Threshold
	P14/P60 (End of Year Summary) & P35 (Employers Annual Return) 
	New P46 (Pen) Return
	Amended P45 Design
	Other Software Changes

	Upgrade Procedure for Capital Gold Payroll and Online Filing Manager
	STEP 1: Before You Begin
	STEP 2: Upgrading the Software
	STEP 3: Checking the Upgrade was Successful
	STEP 4: Installing Online Filing Manager (2.70)

	Doing the 2008-09 Year End in Capital Gold Payroll
	STEP 5: Doing the 2008-09 Year End

	Starting the 2009-10 Tax Year in Capital Gold Payroll
	STEP 6: Starting the New Tax Year

	2009-10 PAYE, NI and Statutory Rates in Capital Gold Payroll
	Software Changes in Online Filing Manager (2.70)
	Changes to the XML File Content
	Changes to the PAYE End of Year Wizard

	Where to Find More Information
	General PAYE and NIC Issues
	Guidance on the Statutory Payroll Changes
	Links to Useful Web Sites

	Glossary of Terms
	General
	Statutory Payments 
	Pay, Tax and National Insurance

	Key Dates for Your Payroll Diary


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /PageByPage
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.6
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 300
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly true
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (sRGB IEC61966-2.1)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /CHS <>
    /CHT <>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <>
    /NLD (Gebruik deze instellingen om Adobe PDF-bestanden te maken die moeten worden gecontroleerd of die moeten voldoen aan PDF/A-1b, een ISO-standaard voor de langetermijnopslag \(archivering\) van elektronische documenten. Zie voor meer informatie over het maken van PDF/A-compatibele PDF-documenten de Acrobat-gebruikershandleiding. PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents that are to be checked or must conform to PDF/A-1b, an ISO standard for the long-term preservation \(archival\) of electronic documents.  For more information on creating PDF/A compliant PDF documents, please refer to the Acrobat User Guide.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


